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Introduction to NetBackup
for Lotus Notes

This chapter includes the following topics:

About NetBackup for Lotus Notes

About the features for NetBackup for Lotus Notes

About supported Lotus Notes database configurations
About the Lotus Notes database files that can be backed up
About Lotus database transaction logging styles

About recycling Lotus database transaction log extents
About Lotus Notes backup operations

About Lotus Notes restore operations

About NetBackup for Lotus Notes

NetBackup for Lotus Notes provides online backups and restores of Lotus Notes
databases and individual mailboxes when Domino server has been installed. This
capability is provided as an add-on or extension to the NetBackup client software.

See “About the features for NetBackup for Lotus Notes” on page 8.

See “About Lotus database transaction logging styles” on page 12.

See “About supported Lotus Notes database configurations” on page 9.



About the features for NetBackup for Lotus Notes

Introduction to NetBackup for Lotus Notes
About the features for NetBackup for Lotus Notes

Table 1-1 describes the features of the NetBackup for Lotus Notes agent.

Table 1-1 Features of NetBackup for Lotus Notes

Feature

Description

Online backup

Lotus Notes databases, mailboxes, and transaction logs can be
backed up without taking down the Domino server. This feature
ensures the availability of Lotus Notes services and data during
the Lotus Notes backup.

Restore operations

An administrator that uses the NetBackup client can browse Lotus
Notes database and mailbox backups and select the ones to be
restored.

Transaction logging

NetBackup for Lotus Notes takes advantage of the ability of Domino
to log transactions against one or more Lotus Notes databases and
mailboxes. Transaction logging may be circular style, linear style,
or archive style.

Point in time recovery

Transaction logging enables NetBackup for Lotus Notes to perform
a point-in-time recovery of a logged Lotus Notes databases and
mailboxes.

Tight NetBackup
integration

Tight integration with NetBackup indicates the following:

= An administrator already familiar with NetBackup can easily
configure and use NetBackup backup and restore Lotus Notes
databases and transaction log extents.

s Features and strengths of the NetBackup product suite are also
available with NetBackup for Lotus Notes. These features
include software data compression, scheduled and user-directed
operations, and multiple data stream backups. Many of these
features are described in detail in the NetBackup Administrator’s
Guide, Volume |.

Central administration

Administrators can define Lotus Notes policies, back up and restore
Lotus Notes databases, and back up and restore archive-style
transaction log extents from a central location.

Media management

Lotus Notes database backups are saved directly to a wide variety
of storage devices that the NetBackup master server supports.
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About supported Lotus Notes database configurations

Table 1-1 Features of NetBackup for Lotus Notes (continued)

Feature

Description

Automated backups

Administrators can set up schedules for automatic, unattended
backups for local or remote clients across the network. These
backups can be full or incremental and are managed entirely by
the NetBackup server from a central location. The administrator
also can manually back up clients.

Compression of
backups

Compression increases backup performance over the network and
reduces the size of the backup image that is stored on the disk or
tape. This feature is only supported for Lotus Notes clients on
Windows.

Checkpoint restart for
backup jobs

With checkpoint restart, NetBackup can retry a failed backup from
the last checkpoint rather than restart the entire job. With this
feature, the NetBackup administrator can also pause a job and
resume it later.

Backups of Domino
Partitioned Server

Administrators can back up databases from Domino partitioned
servers.

(UNIX or Linux)
Backups of multiple
Domino installations

Administrators can back up databases within multiple Domino
installations.

NetBackup for Lotus Notes agent does not support Encrypting File System (EFS)
based backup and restore. For a workaround when your NetBackup environment

has the EFS feature, you can refer to the following tech note on the Veritas Support

website:

http://www.veritas.com/docs/000115039

See “About Lotus database transaction logging styles” on page 12.

See “About Lotus Notes backup operations” on page 13.

See “About performing backups and restores of Lotus Notes databases” on page 45.

About supported Lotus Notes database

configurations

NetBackup for Lotus Notes supports backups and restores of the following Lotus
Notes database configurations:

= Domino server databases

9
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About the Lotus Notes database files that can be backed up

Domino server manages the Domino server databases. Databases are located
in a directory that is referred to as the Domino data directory. Databases can
also be linked to this directory by using linked directories or linked databases.
Databases can be logged or unlogged.

Typically the Domino data directory is /db/notesdata Ofr C: \Lotus\Domino\Data.

s Local databases

A description of the databases is as follows:

Logged Domino Server The database agent has the ability to log transactions against one

databases or more Lotus Notes databases. If transaction logging is enabled
on the server, all logged database transactions go into a single
transaction log. This log consists of one or more files or extents.
Where archive-style transaction logging is used, the archived log
files serve as the incremental backup for the logged databases.
Transaction logging must be enabled to recover logged databases.

Unlogged Domino An unlogged database is one in which transaction logging is not
Server databases enabled, or has been disabled for specific server database(s).

Unlogged databases are backed up when a full backup is
performed. Unlogged databases are also backed up when an
incremental backup is performed and the unlogged database has
been recently updated. The database can be restored only to the
point of the latest database backup.

Local databases Local databases are the Lotus Notes databases that are not located
in the Domino data directory, cannot be shared, and cannot be
logged. Local databases are treated similarly to unlogged Domino
server databases when they are backed up and restored.

See “About NetBackup for Lotus Notes” on page 7.

See “About Lotus Notes backup operations” on page 13.

See “About the features for NetBackup for Lotus Notes” on page 8.

About the Lotus Notes database files that can be
backed up

The following files can be backed up during a backup operation:

» Database files that NetBackup for Lotus Notes supports
See “About database files supported by NetBackup for Lotus Notes” on page 11.

= Transaction logs
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About the Lotus Notes database files that can be backed up

See “About Lotus database transaction logs” on page 11.
See “About performing backups and restores of Lotus Notes databases” on page 45.

See “About backups of Windows network shared folders and UNIX NFS directories”
on page 40.

About database files supported by NetBackup for Lotus Notes
NetBackup for Lotus Notes supports the following database types:
= .NTF Lotus Notes template files
= .NSF Lotus Notes server files
» .BOX Lotus Notes mailbox files

For UNIX clients, you can allow Lotus Notes databases with other extensions to be
backed up (or limit the default list of extensions). Create the file
/usr/openv/netbackup/lotus.conf. If the 1lotus.conf file exists, the default
extensions are overridden and only those databases with the extensions listed are
backed up. In the 1otus. conf file, enter each extension on a separate line. Enter
only the extension with no leading period or trailing characters.

See “About performing backups and restores of Lotus Notes databases” on page 45.
See “Adding backup selections to a Lotus Notes policy” on page 35.

See “About directives in the backup selections list for Lotus Notes policies”
on page 38.

About Lotus database transaction logs

The Domino server has the ability to log transactions against one or more Lotus
Notes databases (R5 or later). Because transactions cannot be logged against
database versions earlier than Domino R5, these pre-R5 Lotus Notes databases
are treated as unlogged databases.

All databases are logged by default when the following occurs:
= The administrator enables transaction logging.
= The database is in the Domino data directory.

All logged database transactions go into a single transaction log that consists of
one or more files or extents.

Transaction logging can be either circular, linear, or archive style. When archive-style
transaction logging is used, the archive log files can serve as the incremental backup
for logged databases.
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About Lotus database transaction logging styles

Note: Transaction logging must be enabled to implement the recovery of logged

databases.

See “About performing backups and restores of Lotus Notes databases” on page 45.

See “Adding backup selections to a Lotus Notes policy” on page 35.

About Lotus database transaction logging styles

One of three logging styles can be selected for all logged databases: circular, linear,

or archive.

Transaction logging
style

Circular

Linear

Description

When you enable circular-style logging, the transaction log
extents are reused as the size limit of the log file is reached.
The reuse saves resources, but limits your recovery options.
Transaction log extents are not backed up by database agent
when circular-style logging is enabled. Therefore, you can
only recover logged Lotus Notes databases to the point in
time when the transaction log extents were overwritten.

When you enable linear-style logging, the transaction log
extents function the same as for circular-style logging, with
one exception. With circular-style logging, the size of the
transaction log extents are predefined and limited. For
linear-style logging, the size of the transaction log extents is
user defined and limited in size only by the amount of mass
storage available.
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Transaction logging
style

Archive

Introduction to NetBackup for Lotus Notes
About recycling Lotus database transaction log extents

Description

When you enable archive-style logging, transaction log
extents are generated as needed and are limited in number
only by the capacity of your mass storage. Archive-style
transaction log extents must be backed up, unlike
circular-style and linear-style transaction log extents, which
cannot be backed up. They can be used as the incremental
backup for all logged databases. Backups of the archive-style
transaction log extents ensure that the transaction log extents
are marked as available to be recycled. These backups also
prevent your mass storage from filling up. Unlike circular-style
and linear-style logging, archive-style logging does not limit
the point in time to which a database can be recovered. With
archive-style logging enabled, a logged database can be
recovered to any point in time. This time can be any time
between when the database itself was last backed up to the
current time.

See “About recycling Lotus database transaction log extents” on page 13.

See “About supported Lotus Notes database configurations” on page 9.

About recycling Lotus database transaction log

extents

Following either a successful full backup or differential incremental backup,
archive-style transaction log extents are marked as ready to be recycled. The

database agent does not delete the successfully backed up transaction log extents.

The Domino server manages when a transaction log extent is recycled.

See “About Lotus database transaction logging styles” on page 12.

See “About supported Lotus Notes database configurations” on page 9.

About Lotus Notes backup operations

NetBackup provides the following methods to perform backups:

= Automatic backups

= Manual backups

= User-directed backups

13
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About Lotus Notes backup operations

For more information on these backup methods and other administrator-directed
activities, see the NetBackup Administrator’s Guide, Volume I.

With automatic backups, the NetBackup administrator can schedule backups to
occur automatically and unattended, under the control of the NetBackup master
server.

The manual backup lets the administrator initiate a full backup or incremental backup
that is set up in the policy manager. The manual backup option can be useful for
the following situations:

= To test a configuration
= When workstations miss their regular backups
= Before installing new software (to preserve the old configuration)

= To preserve records before a special event such as when companies split or
merge

In some cases, it may be useful to create a policy and schedule that you use only
for manual backups. Create a manual backup policy by defining a single schedule
that does not have a defined backup window (and therefore never executes
automatically).

User-directed backups require a User Backup schedule type to be defined in the
Lotus-Notes policy. User-directed backups of Lotus Notes databases are similar to
backups of normal files.

A user backup of Lotus Notes databases and transaction log extents is identical to
a full backup with one exception. Transaction log extents are not marked as ready
to be recycled after they are successfully backed up. Because transaction log
extents are not recycled, a user backup is similar to a snapshot of the databases
at a given point in time. The content of ongoing full and incremental backups is not
affected. A user backup is not automatically scheduled and must be initiated on the
target client machine.

See “About supported Lotus Notes database configurations” on page 9.
See “About Lotus database transaction logging styles” on page 12.
See “About performing backups and restores of Lotus Notes databases” on page 45.

See “About directives in the backup selections list for Lotus Notes policies”
on page 38.

See “About backups of Windows network shared folders and UNIX NFS directories”
on page 40.
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About Lotus Notes restore operations

About Lotus Notes restore operations

An administrator can use the NetBackup client to browse for NetBackup for Lotus
Notes backups and select the ones to be restored and recovered. The database
agent supports both restore operations and recovery operations. A restore operation
lets a user restore any previously backed up Lotus Notes databases.

The following operations are performed during a database restore:
= The Lotus Notes database is taken offline.
= The Lotus Notes database (file data) is restored.

= The Lotus change information is applied.
If recovery of logged databases is requested, it is done after all logged and all
unlogged databases are restored.

= The Lotus Notes database is recovered (transactions from transaction logs are
applied).

= The Lotus Notes database is brought online.

Once the restore is complete, NetBackup attempts to recover all logged databases
that were restored. The logged databases that were restored are rolled forward to
a specific point in time by using the appropriate transactions from the required
transaction logs. Then the databases are brought back online. Any required
transaction logs are restored automatically as part of the recovery operation if they
were previously backed up and recycled. Do not restore transaction log extents
manually.

With a server-directed restore, an administrator can browse Domino Server
databases and select the ones you want to restore. NetBackup lets you select the
NetBackup server from which files are restored, view the backup history, and select
items to restore. You can select a specific client or other clients that were backed
up by the selected NetBackup server.

When you redirect to a different client, you can restore to a client other than the
one that was originally backed up. You can redirect the Lotus databases or
directories. The administrator can direct restores to any NetBackup client (regardless
of which client performed the backup). To redirect a restore, the administrator can
use the NetBackup Administration Console on the master server or the Remote
Administration Console.

For the configuration that is needed for this type of redirected restore, see the
NetBackup Administrator’s Guide.

Redirecting a restore to a different path allows a user to restore Lotus Notes
databases to directories that are different from the directories from which the
databases were backed up.
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Installing NetBackup for
Lotus Notes

This chapter includes the following topics:

Planning the installation of NetBackup for Lotus Notes
Verifying the operating system and platform compatibility
NetBackup server and client requirements

Lotus Notes server software requirements

About the license for NetBackup for Lotus Notes
Specifying the Lotus Notes home path (UNIX)

(UNIX or Linux) About adding new Lotus Notes installations

Planning the installation of NetBackup for Lotus

Table 2-1 shows the major installation steps needed to run NetBackup for Lotus
Notes. Each step contains one or more links to pertinent procedures and concepts.
Table 2-1 Installation steps for NetBackup for Lotus Notes
Step Action Description
Step 1 Verify the installation prerequisites. See “NetBackup server and client requirements” on page 17.
See “Lotus Notes server software requirements” on page 18.
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Verifying the operating system and platform compatibility

Table 2-1 Installation steps for NetBackup for Lotus Notes (continued)
Step Action Description
Step 2 Add the license key for NetBackup for | See “About the license for NetBackup for Lotus Notes”
Lotus Notes. on page 18.
Step 3 (UNIX or Linux) Specify the Lotus Notes | See “Specifying the Lotus Notes home path (UNIX)”
home path. on page 18.

Verifying the operating system and platform
compatibility

Verify that the NetBackup for Lotus Notes agent is supported on your operating

system or platform.

To verify operating system and compatibility

1 Go to the following webpage:

http://www.netbackup.com/compatibility
2 In the list of documents, click on the following document:

Application/Database Agent Compatibility List

NetBackup server and client requirements

Verify that the following requirements are met for the NetBackup server:

» The NetBackup server software is installed and operational on the NetBackup
server.

See the NetBackup Installation Guide.

= Make sure that you configure any backup media that the storage unit uses. The
number of media volumes that are required depends on several things:

= The devices that are used and storage capacity of the media
= The sizes of the databases that you want to back up

= The amount of data that you want to archive

= The size of your backups

= The frequency of backups or archives

= The length of retention of the backup images
See the NetBackup Administrator’'s Guide, Volume I.
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Verify that the following requirements are met for the NetBackup clients:

= The NetBackup client software is installed on the computer that has the
databases you want to back up.

= To use the new features that are included in NetBackup for Lotus Notes in
NetBackup 8.1.1, you must upgrade your NetBackup for Lotus Notes clients to
NetBackup 8.1.1. The NetBackup media server must use the same version as
the NetBackup for Lotus Notes client or a higher version than the client.

Lotus Notes server software requirements

Verify the following regarding the Lotus Notes server software on the NetBackup
server or client:

s Lotus Notes server software must be installed and operational.

Partition servers are supported. More than one Lotus Notes installation is
supported on UNIX.

See “NetBackup server and client requirements” on page 17.

About the license for NetBackup for Lotus Notes

The NetBackup for Lotus Notes agent is installed with the NetBackup client software.
No separate installation is required. A valid license for the agent must exist on the
master server.

More information is available on how to add licenses.

See the NetBackup Administrator’'s Guide, Volume I.

Specifying the Lotus Notes home path (UNIX)

After you install NetBackup with a valid license for NetBackup for Lotus Notes, run
this script on the computer where the Lotus Notes vendor software is installed. With
this script, NetBackup can gather additional information about your Lotus Notes
environment.

To specify the Lotus Notes home path

1 Change to the following directory:
/usr/openv/netbackup/bin

2 Run the following script:

./lotusnotes_config


http://www.veritas.com/docs/DOC5332
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(UNIX or Linux) About adding new Lotus Notes installations

3 Supply the home path for the database installation.
For example:

/opt/lotus

4 Add any other database installations, or enter n if you are finished.

(UNIX or Linux) About adding new Lotus Notes
installations

If you install a new Lotus Notes installation after you install NetBackup, you need
to add this new installation to the NetBackup configuration. This action ensures that
all new Lotus Notes installations are included in backup operations.
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Configuring NetBackup for
Lotus Notes

This chapter includes the following topics:

About configuring NetBackup for Lotus Notes

Configuring Lotus fast restores

Defining properties for a Lotus Notes client

About configuring a backup policy for a Lotus Notes database
Configuring a backup policy for Lotus Notes database supporting files

Performing a manual backup

About configuring NetBackup for Lotus Notes

Before you configure NetBackup for Lotus Notes, complete the installation procedure.
After you complete the installation procedure, complete the procedures in Table 3-1
to configure your environment.

Table 3-1 Steps to configure NetBackup for Lotus Notes
Step |Action Description
Step 1 | Configure Lotus fast restores. See “Configuring Lotus fast restores”
on page 21.
Step 2 | Define properties for a Lotus Notes See “Defining properties for a Lotus
client. Notes client” on page 23.
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Table 3-1 Steps to configure NetBackup for Lotus Notes (continued)
Step |Action Description
Step 3 | Configure a backup policy. See “About configuring a backup policy

for a Lotus Notes database” on page 28.

Step 4 | Configure a backup policy for database | See “Configuring a backup policy for

supporting files. Lotus Notes database supporting files”
on page 41.
Step 5 | Test the configuration settings. See “Performing a manual backup”
on page 43.

Configuring Lotus fast restores

During Lotus restores, the NetBackup for Lotus Notes agent automatically restores
any recycled transaction logs that are required for recovery. Typically one transaction
log extent is restored at a time and recovery is completed for the transactions in
that log. Because the restore of the log and application of transactions is a sequential
process, the restore and recovery performance is slow. NetBackup prefetches the
required transaction logs before recovery. Then multiple transaction logs can be
restored at a time and made available for recovery.

To configure Lotus fast restores
1 Review the configuration recommendations.

See “About Lotus fast restore configuration recommendations” on page 22.
2 Configure the transaction log cache path.

This location is where NetBackup temporarily stores the prefetched transaction
logs.

See “About the transaction log cache path” on page 22.
3 Configure the maximum number of logs to restore.

This setting determines how many transaction logs are restored in a single
restore job during recovery.

See “About the maximum number of logs to restore” on page 23.
See “About supported Lotus Notes database configurations” on page 9.
See “Defining properties for a Lotus Notes client” on page 23.

See “Adding backup selections to a Lotus Notes policy” on page 35.
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About Lotus fast restore configuration recommendations
Review the following recommendations when you configure fast restores:

= Sufficient disk space must be available for the specified number of logs in the
transaction log cache location. (Transaction log cache path or
LOTUS NOTES_LOGCACHEPATH specifies this location.)

= Veritas recommends that the transaction log cache directory and the Domino
transaction log directory be on the same file system. This configuration ensures
that the transaction logs are “moved” to the Domino transaction log directory at
the time of recovery rather than being “copied.” (Copying is time consuming.)

= Veritas recommends that you create the cache directory before you start a
restore job.

See “Configuring Lotus fast restores” on page 21.

See “About supported Lotus Notes database configurations” on page 9.
See “About the transaction log cache path” on page 22.

See “Defining properties for a Lotus Notes client” on page 23.

See “Adding backup selections to a Lotus Notes policy” on page 35.

About the transaction log cache path

NetBackup restores the prefetched transaction logs to the directory that is specified
by this parameter. This directory can be specified in the parameter
LOTUS_NOTES_ LOGCACHEPATH in the Windows registry or in the bp.conf file.

See “Defining properties for a Lotus Notes client” on page 23.
See “Defining properties for a Lotus Notes client in the bp.conf file” on page 25.
Note the following when you configure the transaction log cache directory:

» If the specified path does not exist it is created during restore. Veritas
recommends that you create the cache directory before you start a restore job.

= If the user does not have write permission for the folder, the restore job fails
with a Status 5 error.

= [f a path is not specified, transaction logs are restored to the original location,
the Domino transaction log directory.

= If the value of Maximum number of logs to restore is less than or equal to 1,
this path is ignored. The logs are not prefetched; one transaction log extent per
job is restored to the Domino server’s log directory.

= Ifthere is not sufficient space to restore the specified number of logs, NetBackup
tries to restore only the number of logs that can be accommodated. This
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calculation is done only if the cache directory is present before the restore job
is started.

See “About the maximum number of logs to restore” on page 23.
See “About Lotus fast restore configuration recommendations” on page 22.
See “Configuring Lotus fast restores” on page 21.

See “Adding backup selections to a Lotus Notes policy” on page 35.

About the maximum number of logs to restore

This value specifies the maximum number of transaction logs restored in a single
restore job during recovery. This value can also be specified in the parameter
LOTUS_NOTES LOGCACHESIZE in the Windows registry or in the bp.conf file.

See “Defining properties for a Lotus Notes client” on page 23.
See “Defining properties for a Lotus Notes client in the bp.conf file” on page 25.
Note the following when you configure the maximum logs to restore:

» If negative value or 0 is specified or if the value is not specified, then the default
value of 1 is used.

= Ifthe value is greater than 1 the transaction logs are prefetched only. If the value
is less than 1, one transaction log extent per job is restored to the Domino
server’s log directory.

See “About the transaction log cache path” on page 22.

See “Adding backup selections to a Lotus Notes policy” on page 35.

Defining properties for a Lotus Notes client

To run backups and restores successfully, the agent needs to know the following:
For Windows:

» The location of the Lotus program directory (where nserver.exe resides)
The agent extracts the path from the following key in the Lotus registry:

HKEY LOCAL MACHINE\SOFTWARE\Lotus\Domino\Path

If this value is not defined or if the value is not correct, add this information in
the client properties. You can also edit this information in the Windows registry.

» The path to the Lotus notes. ini file

= A temporary directory where NetBackup can store the prefetched transaction
logs
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= The maximum number of logs that can be prefetched in a single restore job,
during recovery

For UNIX or Linux:

= The path where the Domino data directory is located
= (The location where the Lotus program files reside

» The path to the Lotus notes. ini file

= A temporary directory where NetBackup can store the prefetched transaction
logs

= The maximum number of logs that can be prefetched in a single restore job,
during recovery

These variables can be set in the client properties. Or you can define these variables
in the Windows registry or in the bp. conf.

See “Defining properties for a Lotus Notes client from the NetBackup Administration
Console” on page 24.

See “Defining the properties for a Lotus Notes client from the Windows registry”
on page 25.

See “Defining properties for a Lotus Notes client in the bp.conf file” on page 25.

See “Adding backup selections to a Lotus Notes policy” on page 35.

Defining properties for a Lotus Notes client from the NetBackup
Administration Console

The following instructions describe how to define the properties for a Lotus Notes
client using the NetBackup Administration Console.

To define properties for a Lotus Notes client from the NetBackup
Administration Console

Open the NetBackup Administration Console.

2 Expand NetBackup Management > Host Properties > Clients.
3 In the right pane, right-click the client name and select Properties.
4 In the left pane, expand Windows Client or UNIX client and select Lotus

Notes.
5 Inthe Client Properties dialog box, provide the necessary information.
See “Lotus Notes properties” on page 26.

6 Click OK to save your changes.
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Defining the properties for a Lotus Notes client from the Windows

registry

The following instructions describe how to define the properties for a Lotus Notes
client from the Windows registry.

To define properties for a Lotus Notes client from the Windows registry

1
2
3

5

From the Windows Start menu, select Run.
In the Run box, type regedit and press Enter.

In the Registry Editor, open the EkEY LoCAL MACHINE key and navigate the
tree to the following key:

SOFTWARE\Veritas\NetBackup\CurrentVersion\Config

Provide the necessary information.
See “Lotus Notes properties” on page 26.

To close the registry, select File > Exit.

See “Defining properties for a Lotus Notes client” on page 23.

See “Defining the properties for a Lotus Notes client from the Windows registry”
on page 25.

See “Defining properties for a Lotus Notes client from the NetBackup Administration

Console” on page 24.

Defining properties for a Lotus Notes client in the bp.conf file

The following instructions describe how to define the properties for a Lotus Notes
client in the bp. conf file.

To define properties for a Lotus Notes client in the bp.conf file

1

3

Open the bp. conf file.

This file is located in install path/netbackup/.
Provide the necessary information.

See “Lotus Notes properties” on page 26.

Save and close the bp. conf file.

See “Defining properties for a Lotus Notes client” on page 23.

See “Adding backup selections to a Lotus Notes policy” on page 35.
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Lotus Notes properties

The Lotus Notes properties apply to the clients that are currently selected and that
run NetBackup for Lotus Notes.

The following properties can be configured in the Lotus Notes host properties or
by using the nbgetconfig and nbsetconfig commands.

See “Defining properties for a Lotus Notes client from the NetBackup Administration
Console” on page 24.

See “Defining the properties for a Lotus Notes client from the Windows registry”
on page 25.

For UNIX servers: If you have multiple installations of Domino server, the values
in the client properties or the bp.conf only apply to one installation. For other
installations, specify the installation path and location of the notes. ini file with the
LOTUS_INSTALL_ PATH and NOTES_INI_PATH directives in the backup policy.

Table 3-2 Lotus Notes client host properties
Client host | Configuration options Description
properties
Maximum LOTUS_NOTES_LOGCACHESIZE | The maximum number of logs that can be prefetched in a single
:1uml:er of In the Windows registry, this value restore job during recovery. Specify a value greater than 1.
r:gtsorz is a DWORD value. If this value is less than or equal to 1, NetBackup does not gather

transaction logs during recovery. One transaction log extent per
job is restored to the Domino server’s log directory.

LOTUS_NOTES_LOGCACHESIZE = 3
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Table 3-2 Lotus Notes client host properties (continued)

Client host
properties

Configuration options

Description

Transaction
log cache
path

LOTUS_NOTES_LOGCACHEPATH

In the Windows registry, this value
is a string value.

Specify a path where NetBackup can temporarily store the
prefetched transaction logs during recovery.

For example:

s On Windows: D: \LogCache
= On UNIX: /tmp/logcache

If you do not specify a path, during recovery NetBackup restores
the logs to the Domino server's transaction log directory.

Note the following before specifying the Transaction log cache
path:

» If the specified path does not exist then it is created during
restore.

= The restore job fails with a Status 5 error if the user does not
have write permission for the folder.

» Transaction logs are restored to the original location, the
Domino transaction log directory, if a path is not specified.

» If the value of Maximum number of logs to restore is less
than or equal to 1 then this path is ignored. The logs are not
prefetched; one transaction log per job is restored to the
Domino Server’s log directory.

n Ifthere is not sufficient space to restore the specified number
of logs, NetBackup tries to restore only the number of logs
that can be accommodated.

INI path

LOTUS_NOTES_INI

In the Windows registry, this value
is a string value.

Enter the NOTES.INI file that is associated with the server used
to back up and restore the Lotus database. Use this setting to
specify the correct .INI file to back up and restore from Domino
partitioned servers. Specifying the .INI file for non-partitioned
servers is not necessary.

Specify the absolute path to the NOTES.INI file:

= On Windows:
If the notes.ini file is not located in the default directory,
indicate its location in the INI path box. For example:
D:\Lotus\Domino\notes.ini

= On UNIX:
If the notes.ini is not located in the directory that is specified
in the Path, indicate its location here. For example:
/db/notesdata/notes.ini
Include the directory and the notes.ini file name.
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Table 3-2 Lotus Notes client host properties (continued)
Client host | Configuration options Description
properties
Path LOTUS_NOTES_PATH Specify the path where the Lotus Notes program files reside on

In the Windows registry, this value
is a string value.

the client. NetBackup must know where these files are to perform
backup and restore operations. The value in this box overrides
the Lotus registry key, if both are defined.

Specify the path where the Lotus Notes program files reside on
the client:

= On Windows:
Specify the path for Lotus program directory (where
nserver.exe resides). For example:
D:\Lotus\Domino

= On UNIX:
Specify a path that includes the Domino data directory, the
Lotus program directory, and the Lotus resource directory.
For example:
/export/home/notesdata:/opt/lotus/notes/latest
/sunspa:/opt/lotus/notes/latest/sunspa/res/C

The Path value overrides the Lotus registry value, if both are
defined.

About configuring a backup policy for a Lotus
Notes database

A backup policy for a database defines the backup criteria for a specific group of
one or more clients.

These criteria include the following:

Storage unit and media to use
Policy attributes

Backup schedules

Clients to be backed up

Iltems to be backed up, including a list of databases and directives

To back up the database environment, define at least one Lotus-Notes policy with
the appropriate schedules. A configuration can have a single policy that includes
all clients, or there can be many policies, some of which include only one client.
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In addition to the Lotus-Notes policy, configure a Standard or MS-Windows policy
to back up database supporting files.

See “Configuring a backup policy for Lotus Notes database supporting files”
on page 41.

Most requirements for database policies are the same as for file system backups.
In addition to the policy attributes for this database agent, other attributes are
available that you should consider.

See the NetBackup Administrator’'s Guide, Volume I.

To add and configure a policy, see the following topics:

= See “Adding a new NetBackup for Lotus Notes policy” on page 29.

= See “About policy attributes” on page 30.

= See “Adding schedules to a NetBackup for Lotus Notes policy” on page 31.
= See “Adding clients to a policy” on page 35.

= See “Adding backup selections to a Lotus Notes policy” on page 35.

Adding a new NetBackup for Lotus Notes policy
This topic describes how to add a new backup policy for a database.

To create a policy to backup database supporting files, you need to perform a
different procedure.

See “Configuring a backup policy for Lotus Notes database supporting files”
on page 41.

To add a new NetBackup for Lotus Notes policy
1 Log on to the master server as administrator (Windows) or root (UNIX).
2 Start the NetBackup Administration Console.

3 If your site has more than one master server, choose the one on which you
want to add the policy.

4 In the NetBackup Administration Console, select NetBackup Management >
Policies. Then select Actions > New > Policy.

5 Inthe Add a New Policy dialog box, in the Policy name box, type a unique
name for the new policy.

Click OK.
In the Add New Policy dialog box, in the Policy type list, select Lotus-Notes.

The Lotus-Notes policy type does not appear in the drop-down list unless your
master server has a license for the database agent.
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8 Complete the entries on the Attributes tab.
See “About policy attributes” on page 30.
9 Add other policy information as follows:

» Add schedules.
See “Adding schedules to a NetBackup for Lotus Notes policy” on page 31.

» Add clients.
See “Adding clients to a policy” on page 35.

= Add database objects to the backup selections list.
See “Adding backup selections to a Lotus Notes policy” on page 35.

10 When you have added all the schedules, clients, and backup selections you
need, click OK.

About policy attributes

With a few exceptions, NetBackup manages the policy attributes set for a database
backup like a file system backup. Other policy attributes vary according to your
specific backup strategy and system configuration.

Table 3-3 describes some of the policy attributes available for a NetBackup for
Lotus Notes policy. For more information on policy attributes, see the NetBackup
Administrator’s Guide, Volume I.

Table 3-3 Policy attribute descriptions for NetBackup for Lotus Notes
policies
Attribute Description
Policy type Determines the types of clients that can be backed up with the policy. For Lotus Notes

databases, select the policy type Lotus-Notes.

Take checkpoints
every

Enable this feature to have NetBackup take checkpoints during the backup jobs for the policy.

The checkpoint frequency indicates how often NetBackup takes a checkpoint during a backup.
The default is 15 minutes. The Schedule backup attempts global attribute indicates the
number of times that NetBackup attempts a failed backup.

See the NetBackup Administrator’s Guide, Volume | for more information on these options.

Compress

Enables the compression of backups. This option is only supported for NetBackup for Lotus
clients for Windows. A NetBackup for Lotus client on UNIX cannot perform compression. If
you want to use compression and have both Windows and UNIX clients, create two backup
policies. Use one policy for Windows clients and one policy for UNIX clients.

For more information on advantages and disadvantages of compression, see the NetBackup
Administrator’s Guide, Volume |I.
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Table 3-3 Policy attribute descriptions for NetBackup for Lotus Notes
policies (continued)

Attribute

Description

Allow multiple data
streams

Specifies that NetBackup can divide automatic backups for each client into multiple jobs.
Each job backs up only a part of the list of backup selections. The jobs are in separate data
streams and can occur concurrently. The number of available storage units, multiplex settings,
and the maximum jobs parameters determine the total number of streams and how many
can run concurrently. Not all directives in the backup selections list allow for multiple database
streams.

Keyword phrase

A textual description of a backup. Useful for browsing backups and restores.

Adding schedules to a NetBackup for Lotus Notes policy

Each policy has its own set of schedules. These schedules control the initiation of
automatic backups and also specify when user operations can be initiated.

To add a schedule to a NetBackup for Lotus Notes policy
1 In the Policy dialog box, click the Schedules tab.

To access the Policy dialog box, double-click the policy name in the Policies
list in the NetBackup Administration Console.

Click New.

Specify a unique name for the schedule.

Select the Type of backup.

See “NetBackup for Lotus Notes backup types” on page 32.
5 Specify the other properties for the schedule.

See “About schedule properties ” on page 31.

6 Click OK.

About schedule properties

This topic describes the schedule properties that have a different meaning for
database backups than for file system backups. Other schedule properties vary
according to your specific backup strategy and system configuration. Additional
information about other schedule properties is available. See the NetBackup
Administrator’s Guide, Volume I.
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Table 3-4 Description of schedule properties

Property

Description

Type of backup

Specifies the type of backup that this schedule can control. The selection list shows only
the backup types that apply to the policy you want to configure.

See “NetBackup for Lotus Notes backup types” on page 32.

Schedule type

You can schedule an automatic backup in one of the following ways:

= Frequency
Frequency specifies the period of time that can elapse until the next backup operation
begins on this schedule. For example, assume that the frequency is 7 days and a
successful backup occurs on Wednesday. The next full backup does not occur until the
following Wednesday. Typically, incremental backups have a shorter frequency than full
backups.

= Calendar
The Calendar option lets you schedule the backup operations that are based on specific
dates, recurring week days, or recurring days of the month.

Retention

Specifies a retention period to keep backup copies of files before they are deleted. The
retention level also denotes a schedules priority within the policy. A higher level has a higher
priority. Set the time period to retain at least two full backups of your database. In this way,
if one full backup is lost, you have another full backup to restore. For example, if your
database is backed up once every Sunday morning, you should select a retention period
of at least 2 weeks.

NetBackup for Lotus Notes backup types
In a policy’s schedule you define the type of backup(s) you want to perform.

See “Adding schedules to a NetBackup for Lotus Notes policy” on page 31.

Table 3-5 Description of backups types

Type of backup Description

Full backup This backup type is used to back up all the Lotusdatabases that
are identified in the Backup Selections list. Available transaction
logs extents are also backed up if the
BACKUP_TRANSACTION LOGS directive is specified in the Backup
Selections list. All transaction log extents are backed up that are
identified as available for backup by the Domino server. The inactive
transaction log extents are marked as ready to be recycled after
they are successfully backed up. The Domino server handles the
actual recycling of transaction log extents.
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Table 3-5 Description of backups types (continued)

Type of backup Description

Differential Incremental | The type of Lotus Notes database affects how NetBackup performs
backup a differential incremental backup, as follows:

» Unlogged databases or local databases
Backs up all unlogged databases or local databases that were
modified since the last full or incremental backup. The last
modification date, not the time stamp or date stamp of the
database file, determines the time the database was last
modified.

s Logged databases (archival-style logging enabled)
Backs up only those logged databases that were assigned a
new DBIID since the last full or incremental backup.

s Logged databases (circular-style and linear-style logging
enabled)
Backs up all logged databases that were modified or assigned
a new DBIID since the last full or incremental backup. The last
modification date, not the time stamp or date stamp of the
database file, determines the time the database was last
modified.

= Transaction logs
Backs up all transaction log extents that are identified as
available for backup by the Domino server. The inactive
transaction log extents are marked as ready to be recycled when
the backup complets successfully.

See “About supported Lotus Notes database configurations”
on page 9.
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Table 3-5 Description of backups types (continued)

Type of backup Description

Cumulative Incremental | The type of Lotus Notes database that is encountered affects how
backup NetBackup performs a cumulative incremental backup, as follows;

» Unlogged databases or local databases
Backs up all unlogged databases or local databases that were
modified since the last full backup. The last modification date,
not the time stamp or date stamp of the database file,
determines the time the database was last modified.

s Logged databases (archival-style logging enabled)
Backs up only those logged databases that were assigned a
new DBIID since the last full backup.

s Logged databases (circular-style and linear-style logging
enabled)
Backs up all logged databases that were modified or have been
assigned a new DBIID since the last full backup. The last
modification date, not the time stamp or date stamp of the
database file, determines the time the database was last
modified.

= Transaction logs
Backs up all transaction log extents that are identified as
available for backup by the Domino server. The transaction log
extents are not marked as ready to be recycled when the backup
is completed.

See “About supported Lotus Notes database configurations”
on page 9.

User backup A user backup is identical to a full backup with one exception.
Transaction log extents are not marked as ready to be recycled
after they are successfully backed up. Because transaction log
extents are not recycled, a user backup is similar to a snapshot of
the databases at a given point in time. The content of ongoing full
and incremental backups is not impacted.

A user backup is not automatically scheduled and must be initiated
on the target client machine.

You may want to consider creating a separate policy for User
Backup schedule types. This configuration lets youu easily separate
user-directed and scheduled backups. If you decide to create a
separate policy for user backups, the considerations are similar to
those for automatic backups. One difference is that you do not need
to indicate any backup selections because users select the files.

See “Adding backup selections to a Lotus Notes policy” on page 35.
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Adding clients to a policy

The clients list contains a list of the clients that are backed up during an automatic
backup. A NetBackup client must be in at least one policy but can be in more than
one.

If you want to back up multiple clients, the Lotus Domino Server install path and
the notes. ini location must be identical for each client. If not, the clients must be
backed up through separate policies.

For a NetBackup for Lotus Notes policy, clients you want to add must have the
following items installed or available:

= The Lotus Domino Server or Lotus client

= NetBackup client or server

To add clients to a NetBackup for Lotus Notes policy

1 Open the policy you want to edit or create a new policy.

To access the Policy dialog box, double-click the policy name in the Policies
list in the NetBackup Administration Console.

Click the Clients tab.
Click New.

Type the name of the client and select the hardware and operating system of
the client.

5 Choose one of the following:
= To add another client, click Add.
= If this client is the last client you want to add, click OK.

6 In the Policy dialog box, click OK.

Adding backup selections to a Lotus Notes policy

The backup selections list names the databases and directives that NetBackup
includes in automatic backups of the clients that are included in the policy.
NetBackup uses the same backup selection list for all clients that are backed up
by the policy.

You should back up the following files:
= Allfiles in the Domino data directory
= Any databases that reside outside of the Domino data directory

n  All .1Dfiles
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s Allnotes. ini files

The agent only backs up the databases and directives in the backup selections
lists. To exclude databases from a backup, place them outside the Domino data
directory.

See “About excluding Lotus Notes databases from backups” on page 40.

To back up database links and directory links correctly, you must include the local
and the linked directory in the backup selections list.

See “About backups of Lotus database links and directory links” on page 41.
To create a list of items to back up, perform the following procedures:
= See “Adding directives to the Lotus Notes backup selections list” on page 36.

= See “Adding Lotus databases to the backup selections list” on page 37.

Adding directives to the Lotus Notes backup selections
list

The following procedure describes how to add directives to the backup selections
list.

To add directives to the Lotus Notes backup selections list
1 In the Policy dialog box, click the Backup Selections tab.

To open the Policy dialog box, double-click the policy name in the Policies list
in the NetBackup Administration Console.

Click New.

Add the directives you want to the backup selections list.
From the Windows interface:

= Click the Directives button.

= In the Select Directive dialog box, select the Directive Set.
= From the Directive list, select a directive.

= Click OK.

From the Java interface:

= In the Add Backup Selection dialog box, click the arrow button to the right
of the Pathname or directive box and select a directive.

= Click Add.
= Click OK.
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See “About directives in the backup selections list for Lotus Notes policies”
on page 38.

In the Policy dialog box, click OK.

Any pathnames or directives you specified are appended to the Backup
Selections list.

Adding Lotus databases to the backup selections list

The following procedure describes how to add databases to the backup selections

list.

To add databases to the backup selections list

1

In the Policy dialog box, click the Backup Selections tab.

To open the Policy dialog box, double-click the policy name in the Policies
list in the NetBackup Administration Console.

Click New.

Indicate the database or directory to back up.

From the Windows interface:

Click the Remote Folder button and select the database or directory.

Or type the full path and name of the database or directory.

You can indicate an NFS pathname or a UNC pathname in the Backup
Selections list. For example:

/export/home/lotus/data (NFS pathname)
\\hostname\share\lotus\data (UNC pathname)

For linked databases and directories, include the pathname to the source
databases or directory.

Continue to add any other databases and directories to the list.

From the Java interface:

In the Pathname or directive box, type the full path name of a database or
directory.

You can indicate an NFS pathname or a UNC pathname in the Backup
Selections list. For example,

/export/home/lotus/data (NFS pathname)
\\hostname\share\lotus\data (UNC pathname)

For linked databases and directories, include the pathname to the source
databases or directory.

Click Add.
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= Continue to add any other databases and directories to the list.

=  When you have added all the databases or directories, in the Add Backup

Selection dialog box, click OK.

4 In the Policy dialog box, click OK.

See “Adding backup selections to a Lotus Notes policy” on page 35.

See “About directives in the backup selections list for Lotus Notes policies”

on page 38.

See “About excluding Lotus Notes databases from backups” on page 40.

About directives in the backup selections list for Lotus Notes policies

You can add directives to the backup selections list to indicate database objects
you want to back up. More information is available on backup selections.

See “Adding backup selections to a Lotus Notes policy” on page 35.

Table 3-6

Lotus Notes directives in the backup selections list

Directive

Description

ALL_LOTUS_DATABASES

Performs the backup on all Lotus Notes databases on each of the selected
clients. ALL LOTUS_ DATABASES means both local databases and Domino
server databases.

Note: This directive is supported only on UNIX clients. For Windows
clients, create a backup selections list that includes the directories that
contain the actual Lotus Notes databases.

Note: Usingthe ALL_LOTUS DATABASES directive can have tremendous
performance issues on clients with large or multiple local drives. In this
case, specify more specific directories or databases in the backup
selections list. For example, specify the Domino data directory.

If this directive is encountered during a backup of a Lotus-Notes Windows
client, the backup fails with a status 69: The file list string
is invalid. If you have both UNIX and Windows clients, create at least
two policies: one exclusively for UNIX clients and another exclusively for
Windows clients.

BACKUP_TRANSACTION_LOGS

Backs up all transaction log extents that Domino server identifies as
available for backup.
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Table 3-6 Lotus Notes directives in the backup selections list (continued)
Directive Description
NEW_STREAM In a backup policy, the NEW_STREAM directive is used to define a new

stream of data.
A stream can be any one of the following:

» Asingle stream for a particular partition of a Domino partitioned server

= Multiple streams for a single partition on a non-partitioned Domino
server

= (UNIX or Linux) A single stream for a particular installation of Domino
server installed on a client

To use the NEW_STREAM directive, the Allow multiple data streams
attribute must be enabled for the policy on the Attributes tab.

To schedule a backup of more than one partition from a single policy, you
must back up each Domino partition with a separate data stream. Use the
NEW_STREAM directive and the NOTES INI PATH= directive for each data
stream.

(UNIX or Linux) To schedule a backup of multiple installations of Domino
server on the same host, backup each Domino server with a separate data
stream. Use the NEW_STREAM directive and the NOTES INI PATH and
LOTUS INSTALL PATH directives for each data stream.

For more information on the NEW _STREAM directive, see the NetBackup
Administrator’s Guide, Volume |I.

NOTES_INI_PATH=

This directive identifies the location of the notes.ini file that is associated
with the particular server partition that is used to perform the backup.

(UNIX or Linux) This directive can also identify the notes.ini file that is
associated with the particular server installation that is used to perform
the backup.

To configure a backup for a Domino partitioned server, use this directive
to indicate the absolute path for the notes.ini file. This file should be
associated with the server partition you want to use. The server partition
that is specified has an effect on how a database is backed up (logged or
unlogged). It also affects which set of transaction log extents is backed
up.

(UNIX or Linux)

To configure a backup for one of the multiple installations of Domino server,
use this directive to indicate the absolute path for the notes.ini file. This
notes.ini file should be associated with the server installation to be used.
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Table 3-6 Lotus Notes directives in the backup selections list (continued)
Directive Description
LOTUS_INSTALL_PATH= This directive identifies the location of Lotus program files that are

associated with a particular installation of Domino server.

(UNIX or Linux) To configure a backup for one of the multiple installations
of Domino server, indicate the absolute path where the Lotus program
files are installed.

About backups of Windows network shared folders and UNIX NFS

directories

The NetBackup for Lotus Notes agent can back up Windows network shared folders
and UNIX NFS directories. A Windows UNC or UNIX NFS pathname can be added
in the Backup Selections list of the Lotus Notes policy. This capability is useful when
Lotus Notes databases reside on network storage such as NAS filers.

Consult the NetBackup System Administrator’s Guide, Volume I, for detailed
instructions on how to back up network drives and the Follow NFS policy attribute.

Contact your IBM Lotus Notes representative to determine if this capability is
appropriate and supported within your Domino environment. This capability within
NetBackup does not imply support by IBM. IBM has published a document,
Statement of Support for Domino on SAN and NAS equipment, regarding Domino
in SAN/NAS environments:

http://www-1.ibm.com/support/docview.wss?uid=swg27002613

About excluding Lotus Notes databases from backups

You can exclude specific Lotus Notes databases from the backup by using database
links and directory links. This method works if the databases to which the links point
are located outside of the Domino data directory.

Identify the databases you want to exclude and move them to a directory outside
the Domino data path. Then, create a Domino d

atabase or a directory link to the database(s). The agent only backs up files with
extensions .nsf, .ntf and .box, and does not follow database links or directory
links.

If you need assistance to create a Domino database or directory links, consult a
Domino administrator. Or visit the IBM Support Web site and review IBM Technote
#1089707:

www.lotus.com/support
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About backups of Lotus database links and directory links

The agent only backs up database files with *.nsf, *.ntf, and *.box extensions
in the directories that are specified in the backup selections list of the policy. The
agent does not automatically follow database links or directory links to the actual
databases.

To correctly back up linked databases or linked directories outside of the Domino
data directory, in the backup selections list add the following:

= The directory containing the Lotus Notes databases

= The directory containing the database link (.nsf file)
OR
The directory containing the directory link (.dir file)

For example, assume that you have a database link file that points to a database.
On Windows, the link file c: \Domino\Data\database.nsf points to the database
E:\Lotus\Data\link.nsf.

On UNIX or Linux, the link file /db/notesdata/mail/database.nsf points to the
database /lotus/data/link.nsf.

To correctly back up the database.nsf file, the backup selection list needs to
include the following entries:

Windows

C:\Domino\Data
E:\Lotus\Data

UNIX or Linux

/db/notesdata/mail/
/lotus/data/

Configuring a backup policy for Lotus Notes
database supporting files

To properly back up a database environment, you must back up not only database
files but also the database supporting files. To back up supporting files for a Lotus
Notes environment, do the following: back up all local drives but exclude the
database and the transaction logs from the backup.

To configure a policy to back up database files, you need to follow a different
procedure.

See “About configuring a backup policy for a Lotus Notes database” on page 28.
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To configure a NetBackup for Lotus Notes backup policy for database
supporting files

1 Log on to the master server as administrator (Windows) or root (UNIX).
2 Open the NetBackup Administration Console.

3 Ifyour site has more than one master server, select the one on which you want
to add the policy.

In the left pane, right-click Policies and select New Policy.

In the Add a New Policy dialog box, in the Policy name field, type a unique
name for the new policy.

Click OK.
Click the Attributes tab.
From the Policy type box, select MS-Windows (Windows) or Standard (UNIX).

© 00 N o

Select other attributes you want.

For more information on attributes for these types of policies, see the NetBackup
Administrator’s Guide, Volume |.

10 Click the Schedules tab and configure the schedules for this policy.

For more information on schedules for these types of policies, see the
NetBackup Administrator’'s Guide, Volume I.

11 Click the Clients tab and add the clients that you want to back up with this
policy.

For more information on how to add clients to these types of policies, see the
NetBackup Administrator’s Guide, Volume |I.

12 Click the Backup Selections tab.

13 Click New.

14 Add the aL1_1ocaLn DprIVEs directive to the backup selections list.
From the Windows interface

s Click the Directives icon.
|

= In the Select Directive dialog box, select the Directive Set.
= From the Directive list, select ALL_LOCAL_DRIVES.
= Click OK.

From the Java interface:

42


http://www.symantec.com/business/support/index?page=content&id=DOC5332
http://www.symantec.com/business/support/index?page=content&id=DOC5332
http://www.symantec.com/docs/DOC5332
http://www.symantec.com/docs/DOC5332

Configuring NetBackup for Lotus Notes
Performing a manual backup

= Inthe Add Backup Selection dialog box, from the Pathname or directive
list, select ALL_LOCAL_DRIVES.

= Click Add.
= Click OK.
15 In the Policy dialog box, click OK.

16 Continue with the instructions for excluding database files from the backup of
a Windows client or a UNIX client.

To exclude database files from a backup of a Windows client
1 Open the NetBackup Administration Console.

2 From the left pane, click NetBackup Management > Host Properties >
Clients.

3 Inthe right pane, select each of the database clients.
Right-click a client name and click Properties.

5 Inthe Client Properties dialog box, expand Windows Client and click Exclude
Lists.

6 For the policy you created to back up the database supporting files, add the
following file types to the list: .nsf, .ntf, .box, .TxN.

See the NetBackup Administrator’s Guide, Volume |, for details on how to
create exclude lists.

7 Click OK.
To exclude database files from a backup of a UNIX client

1 On each database client, create the following file:

/usr/openv/netbackup/exclude list

2 Inthe exclude_list file, add the following file types to the list: .nsf, .ntf, .box,
. TXN.

Performing a manual backup

After you configure the servers and clients in your environment, you can test the
configuration settings with a manual backup. Perform a manual backup (or backups)
with the automatic backup schedules you created. A description of status codes
and other troubleshooting information is available.

See the NetBackup Status Codes Reference Guide.
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See the NetBackup Logging Reference Guide.

To perform a manual backup

Log onto the master server as administrator (Windows) or root (UNIX).
Start the NetBackup Administration Console.

In the left pane, click Policies.

In the All Policies pane, select the policy you want to test.

Select Actions > Manual Backup.

Select the schedule that you want to use for the manual backup.

N OO g R~ ODN -

To check the status of the backup, click Activity Monitor in the NetBackup
Administration Console.
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Performing backups and
restore of Lotus Notes
databases

This chapter includes the following topics:

About performing backups and restores of Lotus Notes databases
About performing user-directed backups of a Lotus Notes database
About performing a Lotus Notes database restore

Redirecting a Lotus Notes restore to a different client

About restoring individual Lotus Notes documents or mail messages

Recovering the Lotus Notes environment

About performing backups and restores of Lotus
Notes databases

Before you perform backups or restores, complete the configuration procedures.
You then can use the Backup, Archive, and Restore interface to back up Lotus
Notes databases, mailboxes, transaction log extents, or directories.
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About performing user-directed backups of a Lotus Notes database

About performing user-directed backups of a

Lotus Notes database

These instructions describe a user-directed backup of a Lotus Notes database

using NetBackup. This information is a supplement to the operating instructions in
the NetBackup Backup, Archive, and Restore Getting Started Guide. Refer to that

guide for detailed backup instructions.

Note: When a user-directed backup is successfully completed, transaction log

extents are not marked as ready to be recycled. Therefore, user-directed backups

should be used for special situations and should not replace regularly scheduled
full backups or incremental backups.

General Options tab

The following options are available for backup operations of Lotus Notes databases.

Table 4-1 General Options tab Lotus Notes backup operations

Option

Description

Contains a list of objects to be backed up.

Specify the absolute path
for the NOTES.INI file
associated with the
server instance to be
used

To back up a Domino partition server or one of Domino
installations, specify the absolute path for the notes. ini file.
This notes.ini file should be associated with the particular server
partition or installation that you want to use to perform the
backup.

The partition you specify affects how a database is backed up
(if logged). It also affects which set of transaction logs are
backed up.

Keyword phrase to
associate with this
backup or archive
(optional)

Specifies a keyword phrase, up to 128 characters in length,
that NetBackup can associate with the image created by this
backup operation. You then can restore the image by specifying
the keyword phrase in the Search Backups dialog box.

All printable characters are permitted including space (“”) and
period (“.”). The default keyword phrase is the null (empty)
string
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Lotus Notes Options tab

Use the Lotus Notes Options tab to specify the absolute path for the notes.ini

file.
Table 4-2 Lotus Notes Options tab
Option Description

Specify the absolute path | To back up a Domino partition server, specify the absolute path
for the NOTES.INI file for | for the notes.ini file. This file should be associated with the
the server instance particular server partition that you want to perform the backup.

The server partition you specify affects how a database is
backed up (if logged). It also affects which set of transaction
logs is backed up.

Performing a user-directed backup of a Lotus database

The following procedure describes how to perform a user-directed backup.

To perform a user-directed backup of a Lotus database

1
2
3

Open the Backup, Archive, and Restore interface.
(Windows) Select File > Select Files and Folders to Back Up.
(UNIX or Linux) Click the Backup Files tab.

The Lotus Notes object appears in the left pane. Select items within this object
that you want to back up. These objects include logged and unlogged Domino
server databases, local databases, and archive-style transaction log extents.

If necessary, change the NetBackup master server that you want to perform
the backup.

If there is more than one master server to which you can send your backups,
ensure that you are connected to the correct one. Ask your NetBackup
administrator if you have questions about which master server to use.

Normally, you do not have to switch master servers unless the administrator
temporarily moved the backups. (For example, because of a problem on the
original master server.) If the change becomes permanent, the administrator
should change your default to reflect the other server.

Specify what you want to back up, as follows:

= Expand the Lotus Notes object and select the databases or mailboxes you
want to back up.

= Expand the Transaction Logs object to select transaction logs for backup.
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You cannot select individual transaction log extents for backup. Instead, to
back up all transaction log extents, select the Transaction Logs object of the
tree. NetBackup then queries the Domino server for the list of transaction log
extents that are available to be backed up.

Select Actions > Backup.
Select the backup options, as follows:

= When you back up a server partition, provide the absolute path for the
notes.ini file.
(On Windows clients, click on the Lotus Notes Options tab.)
Associate this notes. ini file with the particular server partition that you
want to perform the backup.

= (UNIX or Linux) When you back up one of multiple installations of Domino
server, provide the absolute path for the notes. ini file. Associate this
notes. ini file with the Domino installation you want to back up. Also provide
the directory of the Domino server installation.

= When you back up one of multiple installations of Domino server, provide
the absolute path for the notes. ini file. Associate this notes. ini file with
the Domino installation you want to back up. Also provide the directory of
the Domino server installation.

See “General Options tab” on page 46.
See “Lotus Notes Options tab” on page 47.
8 Click Start Backup.

About performing a Lotus Notes database restore

This topic describes how to restore a Lotus Notes database or mailbox. This
information is a supplement to the operating instructions in the NetBackup Backup,
Archive, and Restore Getting Started Guide. Refer to that guide for detailed restore
instructions.

Each partition in a Domino server has its own notes. ini. Therefore Lotus Notes
databases from different partitions must be restored in separate restore operations.

For UNIX or Linux, different installations of Domino server must also be restored
in separate restore jobs.

See “Performing a user-directed backup of a Lotus database” on page 47.

See “About performing backups and restores of Lotus Notes databases” on page 45.
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On this tab you can specify a different location to direct the restore to. By default,
everything is restored to its original directory.

Table 4-3

Restore options on the General tab

Option

Description

Restore everything to
its original location

Restores the selected items to the location from which they were
backed up. This option is the default.

Restore everything to
a different location

Select to restore to a different location, then enter the location to
which you want to redirect the files and directories.

Destination Enter the path to restore to. This field is enabled when Restore
everything to a different location is selected.
Browse This option is available on the Windows interface.

Browse is enabled when Restore everything to a different
location is selected. Click it to browse for the destination directory.

NetBackup browses the local machine where the Backup, Archive,
and Restore interface is running. You cannot browse another
machine, even if you have chose to redirect a restore to a different
client.

Restore individual
folders and files to
different locations

This option appears on the Windows interface.

Specify a different location for each item. To restore files to different
locations, you must mark files (not directories).

To specify a different location, double-click an item.

Restore individual
directories and files
to different locations

This option appears on the Java interface.

Specify a different location for each item. To restore files to different
locations, you must mark files (not directories).

To specify a different location, select an item and click Change
Selected Destinations.

Create and restore to
a new virtual hard
disk file

This option is not available for this agent.

Overwrite existing
files

Overwrites existing the files and directories.

Restore the file using
a temporary filename

This option is available on the Windows interface. It does not apply
when you restore Lotus Notes databases.
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Table 4-3 Restore options on the General tab (continued)

Option Description

Do not restore the file | This option is available on the Windows interface. Prevents any

existing files and directories from being overwritten.

Lotus Notes tab

The following additional options are available for Lotus Notes restore operations.

Table 4-4 Restore options on the Lotus Notes tab

Option

Description

Time to wait for the
database to go offline

Specify the number of seconds that the restore process waits for
a busy database. When a database is to be restored it needs to
be taken offline. If the database cannot be taken offline after the
specified wait time, the restore of that database fails.

Recover databases to
current time

Restores the database to the current date and time. This option
is the default.

Recover database(s) to
specified point in time

Select this option to restore a database to a specific date and
time.

Select either Assign new database instance ID or Assign new
database instance ID and replica ID. Assign new database
instance ID is the default option.

No Recovery

Select this option to restore a logged database. For example,
select No Recovery when you want to restore to a temporary
location quickly. No transaction log recovery is performed on the
restored database, which lets you get the version of the database
at the backup time.

Select either Assign new database instance ID or Assign new
database instance ID and replica ID. Assign new database
instance ID is the default when No Recovery is selected.
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Restore options on the Lotus Notes tab (continued)

Option

Description

Database Identification

You can assign a new database instance ID (DBIID), a new
database instance ID and replica ID, or retain the original IDs
during the restore. The replica ID is used to synchronize two or
more databases that are replicated in the Domino environment.

Select Assign new database instance ID during a restore to
create a new database instance ID, but retain the replica ID. This
option is not applicable when you restore unlogged databases.

Select Assign new database instance ID and replica ID during
a restore to prevent the other databases under replication from

writing over the restored database files. For logged databases,

a new database instance ID and a new replica ID are assigned.
For unlogged databases, a new replica ID is assigned.

Retain original IDs is only available when you restore a database
to the current time.

Wait until resources are
available

Select this option to wait for Domino server Resources to become
available before NetBackup starts the restore process.

Windows:

Specify the absolute
path for the NOTES.INI
file for the server
instance

UNIX or Linux:

Specify the absolute
path for the NOTES.INI
file associated with the
server instance to be
used

To restore a Domino partition server, specify the absolute path
for the notes. ini file. This file should be associated with the
particular server partition you want to perform the restore.

(UNIX or Linux) To restore a one of multiple Domino server
installations, specify the absolute path for the notes.ini file.
This file should be associated with the particular server installation
you want to perform the restore.

The server partition you specify affects how a database is restored
(if logged). It also affects which set of transaction logs are used
for recovery.

Browse

This option is available on the Windows interface.

Click Browse to browse for the directory that contains the
notes.ini file.

NetBackup browses the local machine where the Backup, Archive,
and Restore interface is running. You cannot browse another
machine, even if you have chose to redirect a restore to a different
client.
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Table 4-4 Restore options on the Lotus Notes tab (continued)

Option Description

Specify the directory | This option is available on the Java interface. To restore one of
where Lotus is installed | multiple Domino server installations on a server, specify the
directory where the Lotus program files are installed.

Restoring a Lotus database

You can restore linked databases or directories.

Note: The restore jobs that use point-in-time are initiated from the master server
can fail with a status 12. Specifically, the automatic restore of Lotus Notes transaction
log extents during recovery of the Lotus Notes database can fail. This failure occurs
if the install path of the NetBackup master server is different from the install path
of the NetBackup client.

See the NetBackup Troubleshooting Guide for more information.

Warning: Select only the source databases or directory for restore and not the
database links or directory links. If you attempt to restore the links, the actual
database is deleted. This situation can lead to data loss if the database has not
been backed up.

See the following topics:

s See “Restoring linked databases or directories and manually recreating the link
file” on page 54.

= See “Restoring linked databases or directories and the link file” on page 54.
To restore a Lotus Notes database

1 On the NetBackup client, open the Backup, Archive, and Restore interface.
2 (UNIX or Linux) Log on as Domino server administrative user.

3 (Windows) Select File > Select Files and Folders to Restore > from Normal
Backup.

(UNIX or Linux) Click the Restore Files tab.
5 Select the server, client, and policy type.
(Windows) Select File > Specify NetBackup Machines and Policy Type.

(UNIX or Linux) Select Actions > Specify NetBackup Machines and Policy
Type.
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Provide the following information:

Server to use for backups Select the server you want to perform the operation.
and restores

Source client for restores  Select the client on which the backup was performed

Policy type for restores Select Lotus-Notes.

Click OK.

(UNIX or Linux) Select View > Show Most Recent Backup.
(UNIX or Linux) Select View > Refresh.

NetBackup browses for Lotus Notes database backup images.
Select the database or mailbox you want to restore.

Generally, you should not select transaction log extents for a restore. If a
transaction log extent is required to recover a database, it is restored
automatically as part of the database recovery. It is recycled automatically by
the Domino server when the transaction log extent is no longer required.

The Browse Directory box is not available when you browse for Lotus Notes
backups on a NetBackup UNIX client.

Select Actions > Restore.

On the Lotus Notes tab, choose the recovery option.

See “General tab” on page 49.

See “Lotus Notes tab” on page 50.

Select the database identification option from among the following:

To restore a logged database to an Select Assign new database instance ID.
alternate location on same server

To restore to a point in time Select Assign new database instance ID.

To disable replication on restore Select Assign new database instance ID and
replica ID.

(UNIX or Linux) To perform a Specify the notes. ini and install path for the
restore of multiple instances or of  Domino server.
partitioned server

If the database is in use Specify the Time to wait for database to go
offline (seconds).
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14 To restore from a server partition, provide the absolute path for the notes.ini.
This file is one associated with the particular server partition that you want to
perform the restore.

15 (UNIX or Linux) To restore one of multiple installations of Domino server,
provide the absolute path for the notes. ini file.

This file should be associated with the server installation. Also provide the
directory of the Domino server installation.

16 Click Restore or Start Restore.
See “About performing a Lotus Notes database restore” on page 48.
See “About performing backups and restores of Lotus Notes databases” on page 45.

See “Restoring linked databases or directories and manually recreating the link file”
on page 54.

Restoring linked databases or directories and manually recreating

the link file

The following procedure describes how to restore linked databases or directories
and manually recreating the link file.

Warning: Do not restore the link file.

To restore a linked database or directory

1 Restore the database file to the directory that is referenced in the database or
the directory link.

2 Once the restore is complete, manually recreate the link file in the Domino data
directory.

See “Restoring a Lotus database” on page 52.
See “Restoring linked databases or directories and the link file” on page 54.

See “About performing backups and restores of Lotus Notes databases” on page 45.

Restoring linked databases or directories and the link file

The following procedure describes how to restore linked databases or directories
and the link file.
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Warning: Failure to move the actual database before you restore the link file can
lead to data loss. If you only restore the link, Domino deletes the database that the
link references.

To restore a linked database or directory and the link file

1 Restore the database file to the directory that is referenced in the database or
the directory link.

Move the databases that the link file references to a temporary location.
Restore the database link file.

Move the actual databases back to their original location.

a h~h WODN

On the NetBackup client, open the Backup, Archive, and Restore interface.
See “About performing backups and restores of Lotus Notes databases” on page 45.

See “Restoring linked databases or directories and manually recreating the link file”
on page 54.

Redirecting a Lotus Notes restore to a different

client

A restore redirected to a different client is performed like a regular restore except
that a different destination client is selected. Optionally, a different source client
can also be selected.

You can also perform a standard restore.

See “About performing a Lotus Notes database restore” on page 48.

Note: The point-in-time restore jobs that are initiated from the master server can
fail with a status 12. Specifically, the automatic restore of Lotus Notes transaction
log extents during recovery of the Lotus Notes database can fail. This failure occurs
if the install path of the NetBackup master server is different from the install path
of the NetBackup client.

See the NetBackup Troubleshooting Guide for more information.

To redirect a Lotus Notes restore to a different client
1 On the NetBackup client, open the Backup, Archive, and Restore interface.
2 (Windows) Open a Restore window.

(UNIX or Linux) Click the Restore Files tab.
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3 (Windows) Select Actions > Specify NetBackup Machines and Policy Type.
(UNIX or Linux) Select File > Specify NetBackup Machines and Policy Type.
4 From the Source client for restores list, select the client.

The source client is the computer name whose backup images you want to
browse.

From the Policy type for restores list, select Lotus-Notes.

From the Destination client for restores list, select the client to which to
redirect the restore.

The NetBackup for Lotus Notes agent must be installed on the destination
client.

7 Click OK.
NetBackup browses for Lotus Notes backup images.
See “About performing backups and restores of Lotus Notes databases” on page 45.
See “Restoring a Lotus database” on page 52.
See “Performing a user-directed backup of a Lotus database” on page 47.

See “About restoring individual Lotus Notes documents or mail messages”
on page 56.

See “Recovering the Lotus Notes environment” on page 57.

About restoring individual Lotus Notes documents
or mail messages

The NetBackup for Lotus Notes agent restores entire Lotus Notes databases. To
restore individual documents or mail messages, restore the entire database under
a temporary name on the production server or an alternate server. Once the restore
completes, you can copy individual documents or mail messages from the temporary
database into the actual database with the Lotus Notes client.

See “About performing backups and restores of Lotus Notes databases” on page 45.
See “Restoring linked databases or directories and the link file” on page 54.

See “About performing user-directed backups of a Lotus Notes database”
on page 46.
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Recovering the Lotus Notes environment

If you need to recreate the Lotus Notes environment, restore both Lotus Notes
databases and regular files from backup.

To recover the Lotus Notes environment

1
2

Reinstall the Domino server software.

Restore the Domino configuration files (* . id) from the file system backup
image.

Restore these files to the path of the current Domino server installation.
Configure the Domino server.

The *. id files that were restored in the previous step can be used to configure
the Domino server for the first time.

If the previous Lotus Notes environment had transaction logging enabled:

» Enable transaction logging on the new Domino server, by using the Domino
Administrator application.

= Restart the Domino server to create new transaction logs.
Shut down the Domino server.

Make the following change in the notes. ini file.

TRANSLOG_Status=0

Add the following line to the notes. ini file:

TRANSLOG mediaonly=1

Move or delete any files that may exist in the translog path directory.
For example, nlogctrl.1£h or any transaction log extents.

Copy the transaction log extents from the previous Domino server installation
into the current transaction log directory.

Or, you can restore the transaction log extents by using the Backup, Archive,
and Restore interface. The transaction log extents should have a timestamp

later than the timestamp of the backup image from which the databases are

restored.

57



10

11

12
13

14

15

Performing backups and restore of Lotus Notes databases | 58
Recovering the Lotus Notes environment

Make the following changes to the notes. ini file:

TRANSLOG_Status=1
TRANSLOG MediaOnly=1
TRANSLOG_Style=1

Start the Domino server to create the new control file of the restored transaction
log extents.

Shut down domino server.

Use the Backup, Archive, and Restore interface to restore the Lotus Notes
databases or mailboxes from the Lotus Notes backup image, as follows:

» If transaction logging is enabled, select the point-in-time to which you want
to recover the databases.

» If point-in-time is not selected, the database rolls forward to the most recent
available version.

After the recovery of the Lotus Notes databases is complete, make the following
change to the notes. ini file.

TRANSLOG_MediaOnly=0
(Or, remove the setting from notes.ini.)

Start the Domino server.

If backup images of non-Lotus Notes databases are not available, you can
configure the newly installed Domino server by creating new . id files.

See “About performing backups and restores of Lotus Notes databases” on page 45.

See “Performing a user-directed backup of a Lotus database” on page 47.

See “About performing a Lotus Notes database restore” on page 48.

See “Restoring linked databases or directories and the link file” on page 54.
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This chapter includes the following topics:
= About Domino clustering components
= Backing up a Domino replicated or clustered environment

= About the restore and recovery in a Domino replicated or clustered environment

About Domino clustering components

Several components work together to control a Domino cluster. These components
include the Cluster Manager, the Cluster Database Directory, the Cluster Database
Directory Manager, and the Cluster Replicator.

The Cluster Manager runs on each server in a Domino cluster and monitors the
state of the other servers in the Domino cluster.

The Cluster Manager performs the following tasks:

= Determines which servers belong to the Domino cluster

= Monitors for server availability and workload

= Fails over database requests due to unavailability of a clustered Domino server
= Performs workload balancing

The Cluster Database Directory (CLDBDIR.NSF) is replicated on every server in a
Domino cluster. The Cluster Database Directory contains information for each
database on each server in the Domino cluster. This information includes file name,
server, replica ID, cluster replication status, and out-of-service information. The
different cluster components use this information to perform their tasks.

The Cluster Database Directory Manager (CL.DBDIR) task on each server manages
the Cluster Database Directory and keeps it up to date. The Cluster Database
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Directory Manager also monitors the status of each database to determine if they
are out of service or not yet deleted.

The Cluster Replicator (cLrREPL) task constantly synchronizes the database replicas
in a Domino cluster. Changes to the database are pushed immediately to the other
replicas in the cluster. This event-drive replication ensures that each time a database
is accessed that it contains the most up-to-date data. The Cluster Replicator task
pushes changes only to those servers in a Domino cluster. The traditional scheduled
replication is used to replicate changes to and from servers outside a Domino
cluster.

Because Domino stores replication events in memory only, both the source server
and destination server must be available for the replication to complete successfully.
If a destination server is not available, the replication events are stored on the
source server until the destination server becomes available. If the source server
shuts down before the replication completes, the replication events in memory are
lost. To prevent this loss, configure immediate replication with all members of the
Domino cluster whenever a Domino cluster server is restarted. Perform scheduled
replications between Domino clustered servers on a regular basis to help maintain
database consistency for all members of the Domino cluster.

See “Backing up a Domino replicated or clustered environment” on page 60.

See “About the restore and recovery in a Domino replicated or clustered
environment” on page 61.

See “About the restore and recovery in a Domino replicated or clustered
environment” on page 61.

See “About Domino partitioned servers” on page 64.

Backing up a Domino replicated or clustered
environment

If you use transaction logging, configure your Domino cluster environment as follows:
= Enable archive-style logging on the server that functions as your backup server.

= Enable circular-style or linear-style logging on all other servers in the Domino
cluster.
By running circular-style or linear-style logging on the non-backup servers, you
have all the advantages of transaction logging. These advantages include data
reliability and integrity. Also, improved performance can be attained without
having to manage (recycle) the archival-style transaction logs.

= Back up the Domino files that are not part of the database as part of a standard
backup.
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These files include the notes.ini, user certificates IDs, server certificates IDs,
and the cluster.ncft.

See “About Domino clustering components” on page 59.

See “About the restore and recovery in a Domino replicated or clustered
environment” on page 61.

See “About performing backups in a Domino partitioned server environment”
on page 65.

restore and recovery in a Domino
or clustered environment

Domino clustering is a “software” clustering solution that relies on software replication
to provide consistency of the databases across all members of the cluster. To
achieve the result you want, knowledge of how replication functions is vital.

See “Example of clustered environment with three Domino servers” on page 62.
See “Example of clustered environment with four Domino servers” on page 61.
See “Backing up a Domino replicated or clustered environment” on page 60.
See “About Domino clustering components” on page 59.

See “About Domino partitioned servers” on page 64.

Example of clustered environment with four Domino servers

The environment is a Domino clustered environment with four Domino servers as
members of the Domino cluster. Server A is identified as your backup server and
runs archive-style transaction logging. Servers B, C, and D run circular or linear-style
logging. To provide load balancing across all the servers, replicas of all databases
exist on all four servers in your Domino cluster. A successful full backup of all
databases was completed earlier in the week. Successful incremental backups of
the archival-style transaction logs are completed every four hours, with the last one
completing two hours ago. At 2:30 P.M., a user complains that the database
acme.nsf is corrupted, while they modified the database on server C over the last
30 minutes. Unfortunately, because the environment is a Domino cluster
environment, the corruption is replicated to all four member servers. The users
state that the database was in a consistent state when they began to modify the
database.

To restore a database to a consistent state do the following:



Domino clustering | 62
About the restore and recovery in a Domino replicated or clustered environment

= On server A, perform a point-in-time recovery of the database acme . nst. Select
the database acme.nsf from the last successful backup of the database (for
example, a full backup that was completed successfully earlier in the week).
Begin the restore.

= On the Lotus Notes tab of the Restore Marked Files dialog box, select the
Assign new database instance ID and replica ID option. Select the Recover
database(s) to specified point in time option. Specify today’s date at 2:00
P.M. (the time that the user started to modify the database) as the point-in-time
for recovery.

= After the restore or recovery is successful, a version of acme . nsf from 2:00 P.M.
today should exist on server. Verify the consistency of acme.nsf on server A.
If all is as expected, from server A create new replicas of acme.nsf on servers
B, C, and D. Cluster replication should now be functional on servers A, B, C,
and D, with a consistent version of acme .nsf.

See “About the restore and recovery in a Domino replicated or clustered
environment” on page 61.

See “About Domino partitioned servers” on page 64.

See “Example of clustered environment with three Domino servers” on page 62.

Example of clustered environment with three Domino servers

The environment is a Domino clustered environment with three Domino servers as
members of the Domino cluster. Server C is identified as your backup server and
is running archive-style transaction logging. Servers A and B are running
circular-style or linear-style logging. To provide high availability and load balancing
of mail, replicas exist on several servers. Databases A-L exist on servers A and C.
Databases M-Z exist on servers B and C. A successful full backup of all databases
was completed earlier in the week. Successful incremental backups of the
archive-style transaction logs are completed every four hours, with the last one
completing two hours ago. Today a user discovers that 30 mail messages were
accidentally deleted. They were deleted yesterday at about 3:30 P.M. and were
stored in the database mander.nsf.

To recover accidentally deleted mail messages do the following:

= On server C, perform a point-in-time recovery of the following database:
UNIX or Linux: /mail/mander.nsf
Windows: mail\mander.nsf
Select the database from the last successful backup of the database (for
example, the full backup that was completed successfully earlier in the week).
Begin the restore.
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On the Lotus Notes tab of the Restore Marked Files dialog box, select the
Assign new database instance ID and replica ID option. Select the Recover
database(s) to specified point in time option. Specify yesterday’s date at 3:25
P.M. (the time right before the user deleted the mail messages) as the
point-in-time for recovery.

A version of the database is recovered to yesterday at 3:25 P.M. and a database
that contains the deleted messages should exist on server C. Verify the existence
of messages in the mander.nsf database on server C. If all is as expected, copy
the accidentally deleted messages from the database on server C to the database
on server B.

After the copy, verify the existence of the messages in the database on server
B. If all is as expected, from server B create a new replica of the following
database on server C.

Windows: mail\mander.nsf

UNIX and Linux: /mail/mander.nsf

Cluster replication should now be functional for the database on servers B and
C.

In this example the Assign new database instance ID and replica ID option
is chosen. If the Assign new database instance ID option was chosen instead,
the final results of the recovery would be different. The restored database would
function the same, except that the replica ID would not be changed. The database
would be recovered to the specified point-in-time. However, because the replica
ID was not changed during the restore, it would match the replica ID on server
B. Therefore, all the changes to the database between the point-in-time to which
the database was recovered and the current time (including the deletion of the
30 mail messages) eventually is replicated to the database on server C. Two
identical copies of the database exist, one on server B and the other on server
C. Both copies are the same as when the restore was started on server C.

See “About the restore and recovery in a Domino replicated or clustered
environment” on page 61.

See “About Domino partitioned servers” on page 64.

See “Example of clustered environment with four Domino servers” on page 61.
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This chapter includes the following topics:
= About Domino partitioned servers
= About performing backups in a Domino partitioned server environment

= About restoring a Domino partitioned server environment

About Domino partitioned servers

Domino partitioned servers allow multiple Domino servers to run on a single
computer. The advantages of using Domino partitioned servers are to reduce
hardware expenses and minimize the number of computers to administer. Each
Domino partitioned server has its own Domino data directory and notes.ini file. All
partitioned servers on a single computer share the same Domino program directory.

Use different user accounts for each partitioned server. With different users accounts,
you can easily use commands such as nsd to clean up orphaned processes after
a server crash. The database agent easily supports backups and restores of multiple
server partitions with each using a different user account. It is possible to backup
multiple Lotus partitions from a single NetBackup policy; however, back up each
partition by using a separate data stream.

See “About performing backups in a Domino partitioned server environment”
on page 65.

See “About restoring a Domino partitioned server environment” on page 66.

See “About performing backups and restores of Lotus Notes databases” on page 45.
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About performing backups in a Domino
partitioned server environment

The following examples illustrate two possible configurations of the backup selections
list that can be used to back up a Domino partitioned server environment.

Table 6-1

Backup selections list examples

Environment

Backup policy

The environment is a Domino partitioned
server environment with two partitions.

The Domino data directory for partition 1 is
locatedat D: \Lotus\Domino\datal. The
Domino data directory for partition 2 is
located at D: \Lotus\Domino\data2.

To back up this environment with two separate NetBackup policies, add
the following to the backup selections list:

Policy 1

NOTES INI_ PATH=D:\Lotus\Domino\datal\notes.ini
D:\Lotus\Domino\datal\

Policy 2

NOTES_INI_PATH=D:\Lotus\Domino\data2\notes.ini
D:\Lotus\Domino\data2\

The environment is a Domino partitioned
server environment with two partitions.

The Domino data directory for partition 1 is
located at /db/notesdatal. The Domino
data directory for partition 2 is located at
/db/notesdata?.

To back up this environment with two separate NetBackup policies, add
the following to the backup selections list:

Policy 1

NOTES_INI_ PATH=/db/notesdatal/notes.ini
/db/notesdatal

Policy 2

NOTES INI PATH=/db/notesdata2/notes.ini
/db/notesdata?2
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Backup selections list examples (continued)

Environment

Backup policy

The environment is a Domino partitioned
server environment with three partitions.

The Domino data directory for each partition
is located as follows:

s Partition 1, D: \Lotus\Domino\datal
m Partition 2, D: \Lotus\Domino\data?2
m Partition 3, D: \Lotus\Domino\data3

Each partition is configured to use archive-style transaction logging. To
back up this environment with a single NetBackup policy, add the
following to the backup selections list:

NEW_STREAM

NOTES_ INI_ PATH=D:\Lotus\Domino\datal\notes.ini
D:\Lotus\Domino\datal

BACKUP TRANSACTION LOGS

NEW_STREAM

NOTES INI PATH=D:\Lotus\Domino\data2\notes.ini
D:\Lotus\Domino\data2

BACKUP_TRANSACTION_LOGS

NEW STREAM

NOTES INI PATH=D:\Lotus\Domino\data3\notes.ini
D:\Lotus\Domino\data3

BACKUP_TRANSACTION_ LOGS

The environment is a Domino partitioned
server environment with three partitions.

The Domino data directory for each partition
is located as follows:

s Partition 1, /db/notesdatal
s Partition 2, /db/notesdata?2
m Partition 3, /db/notesdata3

Each partition is configured to use archive-style transaction logging. To
back up this environment with a single NetBackup policy, add the
following to the backup selections list:

NEW_STREAM

NOTES INI_ PATH=/db/notesdatal/notes.ini
db/notesdatal

BACKUP_ TRANSACTION LOGS

NEW_STREAM
NOTES_INI_PATH=/db/notesdata2/notes.ini
BACKUP_TRANSACTION_LOGS

NEW_STREAM

NOTES INI PATH=/db/notesdata3/notes.ini
db/notesdata3

BACKUP_ TRANSACTION_ LOGS

About restoring a Domino partitioned server

environment

The user who owns the partition’s Domino data directory must restore the partitioned

server. For Domino server, the notes.ini file determines how a database to be
restored is accessed and which Lotus transaction log extents to use for recovery.
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Because each partition in a partitioned server environment has its own notes. ini,
restore databases from different partitions in separate restore operations.

See “About Domino partitioned servers” on page 64.
See “About performing a Lotus Notes database restore” on page 48.

See “Recovering the Lotus Notes environment” on page 57.
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Domino server multiple
installations (UNIX or
Linux)

This chapter includes the following topics:

= About Domino server multiple installations

= About configuring NetBackup for a multiple Domino server environment
= About backups in a multiple Domino server environment

= About restores a multiple Domino server environment

About Domino server multiple installations

Multiple Domino server installations of same or different versions allow multiple
Domino servers to run on a single computer. These versions can be standalone or
partitioned or a combination of both. The advantages of using Domino partitioned
servers are to reduce hardware expenses and minimize the number of computers
to administer. Each Domino server installation has its own Domino data directory
and notes.ini file.

The NetBackup for Lotus Notes agent uses different UNIX user account for each
installation. When you use different accounts it is easier to use commands such as
nsd to clean up orphaned processes after a Domino server crash. To accommodate
this recommendation, It is possible to back up multiple Domino installations from a
single NetBackup policy. However, each installation must be backed up by using
a separate data stream.
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See “About configuring NetBackup for a multiple Domino server environment”
on page 69.

See “About backups in a multiple Domino server environment” on page 69.

See “About restores a multiple Domino server environment” on page 71.

About configuring NetBackup for a multiple
Domino server environment

Run the following script to configure the NetBackup to support backups and restores
of a multiple Domino server environment.

Run the following script from NetBackup's bin directory:
$./lotusnotes_config

Enter the Lotus install path for each Domino installation. For example:
/opt/lotus655/1otus

See “About Domino server multiple installations” on page 68.
See “About backups in a multiple Domino server environment” on page 69.

See “About restores a multiple Domino server environment” on page 71.

About backups in a multiple Domino server
environment

The following examples illustrate possible configurations of the backup selections
list when used to back up a Lotus multiple server installation environment.
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Multiple Domino server examples

Environment

NetBackup policy

The environment is a multiple Domino server
installation environment that runs with two
installations.

For example: installation 1 of 7.5 version
and installation 2 of 7.6 version are installed
at /opt/lotus75/1lotus and
/opt/lotus76/lotus respectively. The
Domino data directory for installation 1 is
located at /db/notesdatal and the
Domino data directory for installation 2 is
located at /db/notesdata?2.

To back up this environment with two separate NetBackup policies, add

the following to the backup selections list:
Policy 1

NOTES_ INI_ PATH=/db/notesdatal/notes.ini
NOTES_INSTALL_PATH=/opt/lotus75/lotus
/db/notesdatal

Policy 2

NOTES INI PATH=/db/notesdata2/notes.ini
NOTES_INSTALL_PATH=/opt/lotus76/lotus
/db/notesdata2

The environment is a multiple Domino server
installation environment that runs with three
installations.

For example: installation 1 of 7.1 version,
installation 2 of 7.5 version, and installation
3 of 7.6 version are installed at
/opt/lotus71l/lotus
/opt/lotus75/lotus and
/opt/lotus76/lotus, respectively. The
Domino data directory for installation 1 is
located at /db/notesdatal, the Domino
data directory for installation 2 is located at
/db/notesdata2, and the Domino data
directory for installation 3 is located at
/db/notesdata3. Each installation is
configured to use archive style transaction
logging.

To back up this environment with a single NetBackup policy, add following

to the backup selections list:
Policy 1

NEW_STREAM
NOTES_INI_PATH=/db/notesdatal/notes.ini
NOTES_INSTALL_PATH=/opt/lotus71/lotus
/db/notesdatal

BACKUP_ TRANSACTION LOGS

NEW_STREAM
NOTES_INI_PATH=/db/notesdata2/notes.ini
NOTES_INSTALL_PATH=/opt/lotus75/lotus
/db/notesdata2

BACKUP TRANSACTION LOGS

NEW_STREAM

NOTES INI PATH=/db/notesdata3/notes.ini
NOTES_INSTALL_PATH=/opt/lotus76/lotus
/db/notesdata3

BACKUP_TRANSACTION_LOGS

See “About Domino server multiple installations” on page 68.

See “About configuring NetBackup for a multiple Domino server environment”

on page 69.

See “About restores a multiple Domino server environment” on page 71.
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About restores a multiple Domino server
environment

As with restores of a standalone Domino server environment, the user owns the
Domino data directory for the installation that must restore the server installation.
For Domino server, the notes.ini file determines how a database to be restored is
accessed and which Lotus transaction log extents to use for recovery. Because
each Domino server installation has its own notes. ini, Lotus Notes databases
from different installations must be restored in separate restore operations.

See “About backups in a multiple Domino server environment” on page 69.
See “About Domino server multiple installations” on page 68.

See “About configuring NetBackup for a multiple Domino server environment”
on page 69.



Troubleshooting
NetBackup for Lotus Notes

This chapter includes the following topics:
= About NetBackup for Lotus Notes debug logging

= About NetBackup status reports

About NetBackup for Lotus Notes debug logging

The NetBackup master server and client software offers a comprehensive set of
debug logs for troubleshooting problems that can occur during NetBackup
operations. Debug logging is also available for Domino Server backup and restore
operations.

See the following topics for information on how to create the logs and how to control
the amount of information written to the logs.

See “Enabling the debug logs for a NetBackup for Lotus Notes client automatically
(Windows)” on page 73.

See “Debug logs for NetBackup for Lotus Notes backup operations” on page 73.
See “Debug logs for NetBackup for Lotus Notes restore operations” on page 73.

See “Setting the debug level on a NetBackup for Lotus Notes Windows client”
on page 74.

See “Setting the debug level on a UNIX client” on page 74.

After you determine the cause of the problem, disable debug logging by removing
the previously created debug logging directories. Details are available on the
contents of these debug logs.

See the NetBackup Logging Reference Guide.
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Additional information about NetBackup client logs and NetBackup master server
logs is available.

See the online help for the Backup, Archive, and Restore interface.

See the NetBackup Administrator’s Guide, Volume |.

Note: When debug logging is enabled, the files can become large. The same files
are used by normal file backups.

Enabling the debug logs for a NetBackup for Lotus Notes client
automatically (Windows)

You can enable debug logging by running a batch file that creates each log directory.
To create all log file directories automatically, run the following:

install path\NetBackup\logs\mklogdir.bat

Debug logs for NetBackup for Lotus Notes backup operations
To turn on debug logging for standard backup operations, create the following:
(Windows) install path\NetBackup\logs\bpbkar
(UNIX or Linux) /usr/openv/netbackup/logs/bpbkar
See “About NetBackup for Lotus Notes debug logging” on page 72.

See “Setting the debug level on a NetBackup for Lotus Notes Windows client”
on page 74.

Debug logs for NetBackup for Lotus Notes restore operations
To turn on debug logging for restore operations, create the following directory:
install path\NetBackup\logs\tar
/usr/openv/netbackup/logs/tar
For all restores, tar logs exist on the primary client.

See “About NetBackup for Lotus Notes debug logging” on page 72.

See “Setting the debug level on a NetBackup for Lotus Notes Windows client”
on page 74.
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Setting the debug level on a UNIX client

The debug logs are located in /usr/openv/netbackup/logs.
To set the debug level on a UNIX client

¢ Enter the following line in the bp. conf file.
VERBOSE = X

Where X is the debug level you want.

Setting the debug level on a NetBackup for Lotus Notes Windows

client

To control the amount of information that is written to the debug logs, change the
“General” debug level. Typically, the default value of 0 is sufficient. However,
technical support may ask you to set the value higher to analyze a problem.

The debug logs are located in install path\NetBackup\logs.

To set the debug level for the legacy process on a NetBackup for Lotus Notes
client

Open the Backup, Archive, and Restore program
Select File > NetBackup Client Properties.
Click the Troubleshooting tab.

Set the General debug level.

A H ON -

Click OK to save your changes.

To set the debug level for the processes that use unified logging on a
NetBackup for Lotus Notes client

1 Newer NetBackup processes such as ncfgre use unified logging (VxUL). To
increase VxUL logging level, run the following:

install dir\NetBackup\bin\vxlogcfg -a -p 51216 -o OID -s

DebugLevel=6 -s DiagnosticLevel=6
For a list of all OID values, see the NetBackup Logging Reference Guide.
2 To reset the VXUL logging level default value, run the following command:

install dir\NetBackup\bin\vxlogcfg -a -p 51216 -o OID -s

DebugLevel=1 -s DiagnosticLevel=1
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About NetBackup status reports

NetBackup provides many standard status reports to verify the completion of backup
and restore operations. In addition, users and the administrator can set up additional
reports if a site requires them.

The administrator has access to operational progress reports through the NetBackup
Administration Console. Reports can be generated for Status of Backups, Client
Backups, Problems, All Log Entries, Media Lists, Media Contents, Images on Media,
Media Logs, Media Summary, and Media Written. These reports can be generated
for a specific time frame, client, or master server.

See the NetBackup Administrator’s Guide, Volume | for details.

Progress reports on the client allow easy monitoring of user operations. When
reports are created by the NetBackup client for each user-directed backup or restore
operation, administrators can monitor these operations and detect any problems
that may occur.

Viewing the progress report of a NetBackup for Lotus Notes operation

This topic describes how to view the progress report of a NetBackup for Lotus Notes
backup or restore operation.

To view the progress report of a NetBackup for Lotus Notes operation
Click the Task Progress tab.

Click Update Task List.

Choose File > View Status.

Click the task for which you want to check the progress.

Click Refresh.

a h~h WODN

More information is available on progress reports and the meaning of the
messages.

See the NetBackup Backup, Archive, and Restore Getting Started Guide.
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